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Creating Part 

In this tutorial we will machine the part shown in Figure 1. We will 

assume you can create it in Pro\E. The dimensions are shown in the 

next slide.

Figure 1
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Dimension (Inches)
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Adding Text to the Part

The first thing we need to do is add the writing on the front face of the 

plaque. Text is added as a groove feature, so we can use an engraving 

machining operation later on. Open the part you created and follow the 

following steps. 
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Step 1: From the top menu select Insert >> Cosmetic >> Groove

This will bring up the select window. 

Click on the top face of the plaque. Properly selected, the 
top face will turn red. When it does, click OK
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Next click Done Refs In the Menu Manager window.

Menu manager will change to the following screen. 

Select Default and click Okay. The screen will change to sketch view and a 
References window will appear. Click Close. Your screen should look like the 
following following 
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Step 2: Select the Create text as part of a section button . Click once along the vertical 
reference line, then move the mouse vertically upwards (try downwards and see what happen) to 
create a vertical line. Click again to stop. The length of the vertical line is the height of the text. 
The following Text window will appear.

You may add any text you wish. Type your 
text into the box labeled Text Line. As you 
are typing, the text will appear on your part. 
It is important to set the Font to ‘font’ and 
the Horizontal Position to ‘Center’.If your 
text looks approximately like the following, 
you’re okay. When it does, click OKyou’re okay. When it does, click OK

You can change the height of the text and 
vertical position after, using dimension. 
Repeat the above steps to insert second 
text group.
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When you are happy with your text and placement, click the 
Continue With Current Selection button from the right toolbar. 
Your part should look like the following (with your text). If it does, save it and continue on.
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Establishing a Manufacturing Model

This segment of the tutorial will establish the manufacturing models used within this tutorial. 
Two models are utilized: design part and manufacturing. The design part model is the part 
that is to be produced by the manufacturing code generated in this tutorial. The 
manufacturing model is the collection of the design part, assembly model and the 
manufacturing processes generated within the manufacturing object file. 
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Step 1: Select FILE >> NEW. 

Step 2: Select Manufacturing Type on the New dialog box, then select NC ASSEMBLY as            
the Sub-type, Name >> Demo_mfg (Figure 2) 

Figure 2 Figure 3

Step 3: Select MFG MODEL >> ASSEMBLE >> Ref MODEL on the Menu Manager. (Figure 3) 

Step 4: Open yourpart.prt as the part to manufacture. Your block part represents the design 
model. It will be used as geometry to define tool paths within your manufacturing model. 
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Step 5: Using the Default Constraint Type, constrain the location of the reference model. 
(Figure 4). Click        to exit the Component Placement menu. 

Figure 4

Step 6: Select DONE/RETURN to exit the Manufacturing Model (MFG MDL) menu. 
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Step 7: We need to prepare the part to the size of the workpiece(4x6x0.75)inch. To do that we 
will create the mill volume.

Step 8: Select          from the Right Tool Chest

Right Tool Right Tool 

Chest
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Step 9: Click any point on the part to select the part and Click again to select the lower top surface. 
The surface selected will shown in red.

Step 10: Select the Extrude Tool from the Right Tool Chest to extrude the mill volume

Extrude 

Tool

Lower Top Lower Top 

Surface
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Step 11: Click Placement on the lower left corner follow by Define. Click on any point on the lower 
top surface  

Step 10: The Sketch menu will automatically select the default view. Click Sketch



Manufacturing with Pro/Engineer Wildfire 3.0 

Step 12: Select all four edge of the part as References

Step 13: Using Create Rectangle. Draw a rectangle to the size of the part. Click        to exit Sketch

Create 

Rectangle
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Step 14: Set the Depth to 0.25 and click        to finish. 

Step 15: To trim out the part. Click Trim Tool from Right Chest Tool and click on the part 

Trim Tool

Step 16: If it look like the following in No Hidden view. Click
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Step 17: Now we need to set up the Machine Axis system (Machine Zero). 

Step 18: Again go to the Right Chest Tool and click

Step 19: Select the three surfaces shown below. Use the Ctrl key to select multiple surfaces. 

The Machine Zero option allows you to establish the operation's machine coordinate system. When 
machining it is essential that you know where to consider the origin (0,0,0) for machining to be. It is 
common to define one corner of the top surface of the material as zero. The Z-Axis (+) must point 
upward!! Numeric control machine tools manufacture parts through the utilization of a Cartesian 
coordinate system. This coordinate system is used to define precise tool movements. In this tutorial, 
you will create a new coordinate system to serve this purpose; however, an existing coordinate 
system can be selected. 

1st

Surface

2nd

Surface

3rd

Surface
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Step 20: Next, select Orientation on the Coordinate System menu. These steps 
will orient the coordinate system with respect to the part. 

X

Y

Z

Your final Machining Coordinate System should 
appear as shown. Choose OK in the Coordinate 
System Setup Dialog Box. 

Step 21: Use the 1st surface to orient the Z-Axis. Be sure this axis points 
upward, away from your part! Use the Flip option to change the direction an axis 
is pointing. 

Note: The CNC Machine in the workshop in UB is set to work in the Fourth 
Quadrant (X+,Y-,Z-). For this reason always set the Machine Zero on the top left 
corner of your Manufacturing Model and on the highest point along the Z-Axis. 
Also, Z always point away from the part!!!
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Setting the Manufacturing Environment

In this section of the tutorial, you will establish the manufacturing environment. 
Manufacturing mode provides the Manufacturing Setup (MFG SETUP) menu to establish 
specific settings for your model. Within this menu, examples of items that can be set include 
the machining workcell, tooling, the machine coordinate system, and fixtures. You must 
define a workcell and a coordinate system before you can start creating NC sequences. 
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Step 1: Select MFG SETUP on the Menu Manager. 
Pro/E will launch the Operation Setup dialog box. An operation is one specific setup of a machine tool for 
the manufacturing of a design. It can consist of multiple NC Sequences. Within any operation, the minimum 
required setup includes a machine work cell and a machine coordinate system. 
The Operation Setup dialog box (Figure 5) contains the following elements: 

Operation Name >> The operation name identifies the operation within the manufacturing process. The 
default operation names have the format OP010, OP020, where the number gets automatically incremented 
by the system. You can type any name. 

NC Machine >> The name of the machine tool (workcell) used to perform the operation. If you have set up 
some machine tools prior to creating the operation, their names appear in the NC Machine drop-down list. 

Fixture Setup >> This section contains the icons for creating, modifying, and deleting fixture setups. The 
drop-down list contains the names of all the fixture setups defined for the operation, with the name of the 
currently active setup displayed in the list box. 

Machine Zero >> Select or create the Program Zero coordinate system, to be used for NC output and for 
other machining references. 

The Retract group box >> Specify how the tool retracts between the cuts. 

Surface >> Set up the retract surface. 

Tolerance >> Controls maximum deviation of the tool when it moves along a non-planar retract surface. The 
default is 0.1" (in English units) or 1 mm (in metric units). You can type any value. 

Stock Material >> Select a name of the stock material. 
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Step 2:         Select the Machine Tool icon on the Operation Setup dialog box. 

Step 3: On the Machine Tool Setup dialog box, enter the parameters shown below. 

Enter the following parameters: 

• Machine Name: HAAS_TM1

• Machine Type: Mill 

• Number of Axes: 3 Axis 

Step 4: Select OK to exit the Machine Tool Setup dialog box. 

Step 5: On the Operation Setup dialog box, select the Machine Zero pick icon.

Step 6: Pick the Machine Zero we created previously 

Figure 5

Pick as 

Machine 

Zero
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Step 7: We must select a retract, Select the arrow in the Retract box, and the 
Retract Selection window opens. Click the Along Z Axis button, then enter 0.25
for depth. This will make the cutter retract 0.25 inch above the workpiece when 
not in use. click OK

Step 8: Click OK to close the Operation Setup window. It is a good time to save 
your manufacturing model
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Trajectory Milling

Within this segment of the tutorial you will define a Trajectory Milling operation to mill the side 
of the mill volume to clean up the left over and corners. Usually this operation is done after 
the Volume Milling Operation, but due to the set-up and material used in this tutorial we will 
clean up the side of the part first. The parameters that you will set include the cutting tool, 
the tool's parameters, Datum Curve for the trajectory, Height, Direction and the offset. 
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Step 1: Select MACHINING on the Menu Manager. 

Step 2: Select NC SEQUENCE on the Machining menu. 

Step 3: Select MACHINING >> TRAJECTORY >> 2-AXIS >> DONE. 

Step 4: Check the Sequence Setup (SEQ SETUP) Parameters shown below and select Done

Step 5: Enter a name for the Sequence. (example: Trajectory) So it is easier to keep track since we will 

be doing 4 different operation in this tutorial 

After selecting Done, Manufacturing mode will ask to name the operation. 

Notice in Figure the parameters checked for defining. Starting from the top of 

this list (Name in this case), Pro/Ewill in order automatically move you through 

the required menus and dialog box to define each parameter. 
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Step 6: In the Tools Setup menu, enter the tool parameters shown in below

• Tool_ID:  T0004
• Type: END MILL 

• Cutter_Diam (in Diagram): 0.5

Step 7: Click the Settings tab and change the Tool Number to 4 (This is the tool number on the Step 7: Click the Settings tab and change the Tool Number to 4 (This is the tool number on the 
CNC machine in the workshop so keep to it)

Step 8: Click the Apply follow by OK
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Step 9: Select SET on the Manufacturing Parameters menu.(under Menu Manager) 

Step 10: Enter the tool parameters shown in Figure below. Click Advanced and set the 
PLUNGE_FEED to 1.5

Turn Coolant 

Option ON, 

since we are 

working on 

Plexiglas

Step 11: Select DONE on the Manufacturing Parameters menu

The next several steps will define the trajectory you want the mill to move. 

Step 12: Click         from the Right Chest Tool

Step 13: Sketch Menu will pop up and select top surface

Pick this 

surface
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Step 14: Click Sketch on Sketch Menu 

2 Points 

Lines

Step 15: Select all four edge of the part as References

Step 15: Using the 2 Point Lines trace the edge of the part    

Step 16: Click        to exit Sketch and Done on Chain Menu (under Menu Manager)
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Step 18: Click Flip on Direction Menu to change the arrow to pointing Up and Okay

Step 17: Select Z Depth and enter the value -0.25 and Done

Step 19: Select None (arrow will point to the right) and Done

Pointing Up
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We are done setting up the Trajectory Milling operation. We can always check if the 
operation is setup correctly by clicking Play Path >> Screen Play under NC SEQUENCE. 
Press the play button and you can see an animation of the operation. It is a good way to 
double check the depth and the points. If everything look fine then select Done Seq. Save 
your Manufacturing Model
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Volume Milling

This segment of the tutorial will create tool paths to mill out the volume we created previously  
to match the work piece. This will create an ‘island’ in the center of the plaque where we can 
engrave text on the surface. As you may recall, you may have multiple NC Sequences under 
one operation. In this tutorial, the first sequence Trajectory milling the edge. This new 
sequence will mill part to create an ‘island’ in the center

Removing this 

part

Keeping 

‘Island’

part
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Step 1: Select MACHINING on the Menu Manager. 

Step 2: Select NC SEQUENCE >> NEW SEQUENCE on the Machining menu. 

Step 3: Select MACHINING >> VOLUME >> 3-AXIS >> DONE. 

Step 4: Check the Sequence Setup (SEQ SETUP) Parameters shown below and select Done

Step 5: Enter a name for the sequence. (example: Volume) So it is easier to keep track since we will be 

doing 4 different operation in this tutorial 
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Step 6: In the Tools Setup menu, select the previously created tool T0004 (0.5 inch End Mill) and OK. 
We will be using the same tool

Step 7: Select SET on the Manufacturing Parameters menu.(under Menu Manager) 

Step 8: Enter the tool parameters shown in Figure below and Done

Turn Coolant 

Option ON, 

since we are 

working on 

Plexiglas
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Step 9: Now Pro/E is asking which part you want to mill out (remove). Select the 
volume we previously created by clicking on it. 

Select the 

Purple 

Highlighted 

part

We have finish the Volume Milling Sequence. Again to check select Play Path. If 
everything looks good select Done Seq. Save your Manufacturing Modal

Step 10: After you click on the part, Pro/E will ask from which surface you want to 
start the milling from. Select the right vertical edge (shown) and Done
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Hole Making

Within this segment of the tutorial, you will create the NC sequence that will machine/drill 
the part's holes. 
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Step 1: Select MACHINING on the Menu Manager. 

Step 2: Select NC SEQUENCE >> NEW SEQUENCE on the Machining menu. 

Step 3: Select MACHINING >> HOLEMAKING >> 3-AXIS >> DONE. 

Step 4: Check the Sequence Setup (SEQ SETUP) Parameters shown below and select Done

Step 3: Select DRILL >> STANDARD >> DONE

Step 5: Enter a name for the sequence. (example: HoleMaking) So it is easier to keep track since we will 

be doing 4 different operation in this tutorial 
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Step 6: In the Tools Setup menu, enter the tool parameters shown in below

• Tool_ID:  T0006
• Type: BASIC DRILL 

• Cutter_Diam (in Diagram): 0.25

Step 7: Click the Settings tab and change the Tool Number to 6 (This is the tool number on the Step 7: Click the Settings tab and change the Tool Number to 6 (This is the tool number on the 
CNC machine in the workshop so keep to it)

Step 8: Click Apply follow by OK
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Step 9: Select SET on the Manufacturing Parameters menu.(under Menu Manager) 

Step 10: Enter the tool parameters shown in Figure below and Done

Turn Coolant 

Option ON, 

since we are 

working on 

Plexiglas
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Step 11: Select the ADD option on the dialog box, pick all of the axes of the 
holes, then select OK on the Selection box. 

Step 12: Select the DEPTH option on the dialog box. Select AUTO >> OK . 

Step 13: Select DONE/RETURN on the Holes menu 

We have finish the Hole Making Sequence. Again to check select Play Path. If 
everything looks good select Done Seq. Save your Manufacturing Modal
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Engraving

Our last Sequence is the writing on the face of the ‘Island’. This is not a Profile operation 
but uses the Engraving type instead. Engraving is used to make shallow passes on a flat 
face. Engraving follows cosmetic groove features, instead of model geometry. 
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Step 1: Select MACHINING on the Menu Manager. 

Step 2: Select NC SEQUENCE >> NEW SEQUENCE on the Machining menu. 

Step 3: Select MACHINING >> ENGRAVING >> 3-AXIS >> DONE. 

Step 4: Check the Sequence Setup (SEQ SETUP) Parameters shown below and select Done

Step 5: Enter a name for the sequence. (example: Engraving) So it is easier to keep track since we will 

be doing 4 different operation in this tutorial 
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Step 6: In the Tools Setup menu, enter the tool parameters shown in below

• Tool_ID:  T0001
• Type: GROOVING 

• Cutter_Diam (in Diagram): 0.25

Step 7: Click the Settings tab and change the Tool Number to 1 (This is the tool number on the Step 7: Click the Settings tab and change the Tool Number to 1 (This is the tool number on the 
CNC machine in the workshop so keep to it)

Step 8: Click Apply follow by OK



Manufacturing with Pro/Engineer Wildfire 3.0 

Step 9: Select SET on the Manufacturing Parameters menu.(under Menu Manager) 

Step 10: Enter the tool parameters shown in Figure below and Done

Turn Coolant 

Option ON, 

since we are 

working on 

Plexiglas
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Step 11: It is always advised to reduced the retract plane lower (nearer to part surface) 
when engraving. Therefore, here we are changing it from 0.25 to 0.05

Step 12: Finally, you have to choose the groove we created earlier on (click on the text). 
Select DONE/RETURN

We have finish the Engraving Sequence. Again to check select Play Path. If 
everything looks good select Done Seq. Save your Manufacturing Model
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Outputting CL Data & Generating G-Codes 

Within this segment of the tutorial, you will run the operation, to include all NC sequences. After displaying the tool paths, 

this tutorial will show you the procedure for post-processing the CL data. 

Step 1: Select CL DATA on the Menu Manager. 

Step 2: Select OUTPUT >> OPERATION. 

Step 3: Select your current operation from the Selection Menu. Your current operation should be OP010. 

Step 4: Select Display as the location of the output. 

Step 5: Select Done on the Play Path menu. The speed of your display can be slowed or increased with the Time Step 5: Select Done on the Play Path menu. The speed of your display can be slowed or increased with the Time 

increment option. 

Step 6: Select File on the Path menu. 
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Next, you will post-process the CL data to a specific machine tool. 

Step 7: On the Output Type menu, be sure the CL FILE, INTERACTIVE and COMPUTE CL options are selected. 

Step 8: Select Done on the Output Type menu. 

Step 9: On the Save As dialog box, enter Machining_demo as the name for the CL file, then select OK. 

Once the CL data has been created, you send it to a post processor to output the G-code for a specific machine

Step 10: Select Done Output on the Path menu and then select Post Process on the CL DATA menu. Select the file 

Machining_demo.ncl from the Open Dialog box, select Open to close the window. In the PP Options menu make sure 

the Verbose and Trace options are selected. 

Post processing is the act of converting the toolpaths from a standard language file, called a cutter location file (**.ncl), to

the language of our specific CNC machine controller. The resultant file in Pro/E is known as a tape file (**.tap) which the language of our specific CNC machine controller. The resultant file in Pro/E is known as a tape file (**.tap) which 

contains all the “G” codes to control the CNC machine. The post processor is a program which performs the translation 

process. 

Step 11: Select Done on the PP OPTIONS menu and a list of post-processors appears. 

The specific machine tool we have in-house is: uncx01.p11

Step 12: Close the information window and Select DONE/RETURN from the CL DATA menu. 

Step 13: Save your manufacturing file. 

The post-processed file created (Machining_demo.tap) is found in your current working directory. This text file may be 

edited using a standard text editor. 
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Understanding & Editing G-Codes 
Open you .tap file using Notepad. Your G-Codes should look similar to this

%

O0000

(C:\temp\In_Class_Demo\op010.ncl.1)

(10/10/07-12:31:56)

N0010T4M06

S2200M03

G00X0.Y0.

G43Z.25H04M08

Z-.15

G01Z-.25F1.5

X4.F3.

.

.

This is the File name recognize by the Machine. 

Important it always start with the letter ‘O’ not zero 

and follow by number only. NO LETTERS. If not 

the machine won’t accept the codes . 

The first open Bracket will be shown as description 

on the machine. 

N0010 represent the 1st sequence of the operation

T4= Tool #4-0.5 endmill on the machine

You can look up what Mxx,Sxx,Gxx represent 

online or ask staff in the machine shop .
.
N0020T6M06

S2200M03

G00X3.5Y-.5

G43Z.25H06M08

G81X3.5Y-.5Z-.8251R-.15F3.

X2.

X.5

G80

G81X.5Y-5.5Z-.5751R-.15F3.

X3.5

.

.

.
X2.5156Y-4.1667

X2.6719Y-3.75

Y-4.25

Z.25

M30

%

As you scroll down. You will find N0020 (2nd

operation-Hole Drilling) and T6 (changing tool to 

Tool#6 the 0.25 drill)

At the end of the code you will find M30, which 

signal the end of program and stops everything. 

But it doesn’t tell the machine to reset the spindle 

position to origin. We need to add a line of code to 

do so. (Next page)
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We always want to edit the G-codes so it’s easier for the machine operator or you to understand. We will also put comment 

on different lines of the codes, therefore if you go through the codes in another month, you will remember what you did. 

Below is part of the of the G-codes I edited using Notepad. I also included couple of things you must add in, things 

REQUIRED by staff in the machine shop before they will run your program on the machine. I have also higlighted the 

IMPORTANT codes you MUST add in order for the machine to work(These you must add)

%

o46470 

(MAE464 2007 Master Copy)

(Creating a Plaque on plexiglass with engraving text on surface)

(Created by James Wong (Graduate Student))

(Trajectory & Volume Milling- 0.5in Mill)

N0010T4M06

S2200M03

G90G54G00X0.Y0.

G43Z.25H04M08

.

IMPORTANT: The first line I have change the file name to o4647x (x is your group #)

The first set of bracket will be your file description on the machine so type in 

(MAE 464 2007 Group #)

Then you can add another set of bracket to add Note or Comment of the program)

In G-codes (….) represent comment similar to // in C++ language

If you scroll down you should see N0010T4… N0010 represent the first tool change sequence  and T# is the 

tool # you changing to. Add a couple of blank line (just hit Enter) and comment on top keeping note what 

sequence are you at and what is tool#4(here is 0.5 end mill) and the blank lines to find the sequence easily

IMPORTANT: Then I added G90G54 in front of G00X0.Y0. This set of codes tell the machine where the 

machine zero is. Usually it will be generated automatically when the computer is setup to link with machine. 

However, the computers in UB are not so we are adding it manually. .
.
.

(Hole Making-0.25in Drill)

N0020T6M06

S2200M03

G90G54G00X3.5Y-.5

G43Z.25H06M08

G81X3.5Y-.5Z-.8251R-.15F3.

.

.

.
Y-4.25

G00 Z1. M09

G28 G91 Y0. Z0. M05

M30

%

After the editing you can save the file as a .txt file. The machine will accept it. For reference, I have posted my edited 

version online(above is just part of it). To run the G-codes on the machine just save the file onto a USB drive and bring it to 

the machine shop. The machine is equip with a USB slot.

However, the computers in UB are not so we are adding it manually. 

Again here, I have entered the blank lines and the comment stating the Operation and the tool.

IMPORTANT: Again, I added G90G54 in front of G00X0.Y0. 

Repeat both every time when there is a new sequence and tool change.  For this example tutorial we will have 3 

tool change and 3 different operation (1st –Milling (0.5 Mill)/ 2nd HoleMaking(0.25 drill)/ 3rd Engraving (your text))

IMPORTANT: At the very end of the code, just before M30 I have added the following line  

G00 Z1. M09

G28 G91 Y0. Z0. M05

This 2 lines tell the machine to reset the spindle and work table position. Again, usually it will 

be generated automatically when the computer is setup to link with machine. However, the 

computers in UB are not so we are adding it manually. 
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Help and more Information

• If you are not sure what certain thing mean; for example, what PLUNGE_FEED under the Parameters mean. You can go     

to help on Pro/E and do a search.

• The other best way to look for help is google you problem. Usually there will be tutorials prepared by other University; 

however, most of them you will find running on a different version of Wildfire. It is mostly the same other than the change 

on the interface.

• If you are not sure what Feed_Rate, Speed and etc to use. You can go down to the machine shop and ask for help. But 

do not go to them when you have problem with sofware.

• If you have questions about this tutorial or software problem you can contact me by email at kvwong@buffalo.edu
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Questions ?

Prepared by 
KwongVoon Wong

Graduate Student 

University at Buffalo

Fall 2007


